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What is a Resume?
If you have ever applied for a job or internship, you likely have submitted a resume. But what is
a resume and why do we need one? A resume is your personal billboard.
It is your opportunity to share your experiences and qualifications with an employer. It is your
marketing tool designed to land you an interview.
Research shows that employers spend only a few seconds glancing over a resume. This means
your resume needs to be engaging, concise, and easy to read. Employers search for keywords
from the job description and need to be able to find the information quickly and easily. So
you need to craft a resume, but what skills should you include? How should the document be
formatted? Do you need to include color and different fonts to stand out?
There is no perfect resume format, but our staff at the UofL Career Development Center can
help you create and refine a professional resume that will help you get noticed by employers.
This resume guide is your key to the basics of crafting a resume. If you feel you need
additional help, stop by the Career Development Center during drop-in hours or schedule an
appointment with your Career Coach in Cards Career Connection powered by Handshake.

Key Outcomes for Using a Resume
•
•
•
•

Demonstrate how you meet the needs of the hiring audience
Impress your prospective employer with a snapshot of your career, skills, and
accomplishments
Receive an interview offer from interested employer
Create a guide for you and the hiring audience to prepare for an interview

Common Types of Resumes
•
•

•

 hronological Resume – This is the most common resume format. Present education
C
and work experience in reverse chronological order, meaning you list your most recent
experiences first. Skills and accomplishments are described under each entry.
Functional Resume – Your experience is explained under major skill headings rather
than listing experiences chronologically. Experiences may be organized under
categories such as “Leadership,” “Program Management,” “Supervision,” etc. Use the
job description as a guide to develop category headings. This format is seldom used.
Combination (Hybrid) Resume – In many instances, the combination of both the
chronological and the functional formats may be the most effective. This type of
resume is useful for those who are changing career paths or re-entering the workforce
after an extended absence. This format allows for experiences to be separated
into different categories – related and unrelated – making the strongest impact by
placing the most related experiences first, regardless of the dates during which the
experiences took place. The hybrid resume is preferred to the functional resume when
possible.
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Resume Format and Design
When crafting your resume, it is important to keep your intended audience in mind.
Oftentimes, your resume may go through several different channels and it is important to
format it to get through all of those channels. The following recommendations are meant to
get your resume through Applicant Tracking Systems, the Human Resource reviewer, and the
Hiring Manager or Committee.
Your industry will determine some aspects of your resume format and design. Many fields will
expect a traditional, black and white resume, while those in more creative fields (e.g. graphic
design, marketing, advertising, etc.) will expect a resume with more color and personality.
Our biggest piece of advice: do not use a template. Whether you found it on Microsoft Word
or purchased it from Etsy, templates are often difficult to manipulate and do not send well
electronically. Instead, find an example resume format that you like and start from scratch on a
blank Word document. See p. 11 for tips on formatting your resume in Microsoft Word

Length

What is the perfect resume length? You do not want your resume to be too short, indicating
lack of experience and skill; however, you also do not want it to be too long and risk the
employer not reading your relevant qualities. The recommended page length, for your resume,
is 1-2 pages. Typically those finishing their undergraduate degree will have a 1 page resume
while those finishing a graduate or professional degree may have 2 pages. If you go onto a
second page, you should utilize at least 2/3 of the page or condense your information
down to 1 page.

Margins

If you are having trouble fitting your content on your resume you can adjust the margins. The
standard margins are 1” on all sides. If you need the space you can decrease the margins,
but not smaller than 0.5” all the way around. When decreasing the margins, ensure the text
doesn’t appear too crowded.

White Space

As you begin adding content to your resume you might notice large open white spaces (space
without text). Your goal is to use the white space as a tool to enhance the readability of your
resume. When formatting your resume you want to avoid large open spaces, as well as too
much clutter on one page. You can edit the amount of white space on your document by
utilizing both sides of the page. For example, under your education header you can list your
school and degree title on the left then list your graduation date on the right. This helps to
make your resume easily readable and to balance the page.

Font Style and Size

There are a number of standard font styles that are acceptable for your resume, and you will
see many opinions on font styles. While there is no right answer, typically the best fonts to use
are sans serif fonts like Arial, Calibri, Helvetica, Tahoma, and Verdana. These fonts scan better
than a serif font such as Times New Roman.
The main body should be between 10-12 point font. Headings should be slightly larger at 12-14
point, and your name should be the largest item on the page, typically at a size 14 or 16.
Try using italics, bold or CAPITALIZATION for section headings or job titles for visual appeal
and readability. Stay consistent throughout your resume and avoid overdoing the formatting.
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Color Use

Your resume will typically be sent electronically and will then be printed in black and white by
the employer. Therefore, it is recommended that you format your resume in black and white, to
avoid any issues with printing and losing content.
For some fields, it is acceptable to use a little color for your name or headers. A resume for
a creative field has more flexibility in terms of color. The colors used should align with your
personal brand.

Digital Formatting

When submitting your resume to an employer do not send as a Word document, unless
specifically requested to do so. You should send your resume as a PDF to minimize formatting
and compatibility issues.
You may be asked to upload your resume to an online Applicant Tracking System (ATS). In
this case, you should also submit a PDF file of your resume. However, you might be asked to
submit your resume within a text box, and for this you will want to have a “text only” version
of your resume to copy and paste your resume into the text box. Below you can find step-bystep instructions on saving your resume as “text only:”
1.
2.
3.
4.
5.
6.

 pen the final version of your Word document file. “Select All” then choose the “Copy”
O
command.
Open Notepad on your PC or TextEdit on your Mac. Then choose the “Paste”
command.
Review the resume and remove any unusual characters and fix spacing and format
problems.
Add blank lines to improve the readability.
Use keyboard characters to deliver “text only” formatting. This might mean ALL CAPS
for headings.
Save this “text only” version of your resume and have 2-3 people proofread for you.

4

Resume Content
You want to put your most important/relevant information towards the top of your document.
You should consider this when determining how to organize your content. Below are common
headers for content to include on your resume

Contact Information

Your name and contact information should be the first thing an employer sees on your resume.
Your contact information should include:
• Name
• Email
• Phone Number
• Address (optional)
• Links to personal websites, portfolios, or LinkedIn (optional)
Your name should be the biggest thing on the page. You can use the name you typically go by,
but remember that you must use your official name on all application materials. You can also
choose to include your preferred name in parentheses.
Your contact information should include a reliable email address and phone number. Double
check that you have your voicemail set up and your email address is professional and easy for
employers to identify with you. You may choose to use your Louisville email, especially when
applying to graduate programs or internships, but should also set up a professional email at
Gmail, Outlook, etc. for your job search.
You may choose to include your address in your contact information although it is no
longer necessary. It can be helpful to show you are from an area or have ties to an area,
but otherwise, it is best to leave off. You can also include links to any personal websites or
portfolios you have created or to your LinkedIn account. These website links can be left
hyperlinked if submitting electronically so the employer can easily click on the link to visit your
page.

Objective/Professional Summary

You might have heard of the resume objective statement, which tells a prospective employer
your goals for submitting your resume. Most applications are now submitted online,
responding to a particular job posting, so objective statements are less popular in most
industries today. If you choose to include an objective statement, it is recommended that you
make it as specific and targeted as possible. Include details about the position or field and the
skills you can bring to the organization. Avoid generic statements that don’t offer additional
information to the employer.
Some people choose to use a resume summary, also referred to as a career summary,
professional summary, or branding statement. This summary allows you to tell the employer
what you have to offer and why they should hire you. Your resume summary should include
knowledge, skills and expertise that meet the needs of the specific position in which you are
applying. The summary can be in paragraph or bulleted format, and you may also bold or
italicize keywords that you want to highlight.
It is not necessary to use an objective or a professional summary. This information can be
included in your cover letter. Many people choose to save this space to include additional
information in their experiences.
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Education

Having a section dedicated to education allows you to highlight the relevant and often times
required education and training needed for the position. The education section should include:
• Name of the institution(s), City, and State
• Official degree titles and major(s)/minor(s)
• Graduation date
• GPA and scale
After your first year of college, it is recommended you remove any information regarding your
high school education. If you completed a degree from another institution, you will want to
include that information under your current education. All education should be listed in reverse
chronological order with your most recent experience listed first.
You should always include the official degree title for your program. Oftentimes, employers are
seeking specific educational qualifications and your resume might not pass if your degree title
isn’t listed. This is typically something like “Bachelor of Arts,” “Master of Science,” etc. Check
your department’s website to find the official degree title for your program. You can choose to
list your major along with the degree title (e.g. Bachelor of Science in Psychology) or under the
degree as Major: Psychology. Include all majors, minors, and concentrations on your resume.
Include your graduation date with just the month and year it is anticipated. You do not need to
include the words “anticipated” or “expected.” You also do not need to include the date range
for the time you have been at UofL.
Typically, it is recommended to include your GPA if it is above a 3.0. You can choose to include
your major GPA or cumulative GPA but it is important to indicate which you are using and the
scale (e.g. 3.5/4.0). Some applications may require you to include your GPA.
You may also choose to highlight honors and awards, relevant coursework (especially
advanced or relevant elective courses), thesis/dissertation titles, or study abroad experience in
your education section.

Experience

What experiences do you have that will highlight relevant skills and expertise needed for the
specific position? When writing your experience section you want to focus on your skills and
accomplishments instead of just listing work duties. We use experience as the broad term that
encompasses all of your work experience, internships, campus involvement, extracurriculars,
volunteering, etc. Experience included on your resume can be paid or unpaid. It is possible to
have multiple types of experience sections.
For each experience, you will include:
• Organization Name and location
• Position Title
• Dates
• Approximately 2-4 descriptive bullet points
You will list the position title, company/organization, the city and state it is located, and the
period in which you worked there. You do not have to indicate exact dates, instead, include
the month and year for both when you started and finished. If you are using a chronological
resume, these experiences will be listed in reverse chronological order. Under each experience
you want to include 2-4 descriptive bullet points starting with a strong action verb describing
your accomplishments. See more information on creating strong bullet points on pages 8.
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Typical experience sections may include:
• Work Experience
• Course Project/Academic Experience
• Study Abroad (if not included in education)
• Campus/Community Involvement or Extracurriculars
• Research/Capstone
There are many other sections you may choose to include on your resume. You can add any
sections that help to categorize your experiences. You do not have to include all of your work
history. Only include information from high school if it is extremely relevant to the position for
which you are applying or if it is your only work experience.

Technical Skills and Certifications

The skills section is intended for technical skills. Soft skills such as communication, teamwork,
problem-solving etc. should be displayed through your bullet points (see pg. 8). Technical skills
will differ for each field but may include things such as:
• Microsoft Office (Word, Excel, PowerPoint, Access)
• Web skills/programming languages
• Computer software (Adobe, Photoshop, InDesign, Publisher, Canva)
• Equipment (cameras, laboratory equipment)
• Certifications (Certified Nurses Aid, CPR)
• Language Skills (include proficiency level if needed)

References

References are not required for the resume. You do not need to include the statement
“references available upon request.” See our Reference Guide for more information and
examples

7

Effective Resume Writing
We have already mentioned that content is the most important part of your resume, but what
should you include? A strong resume has the content tailored to the job description, field,
or industry. It is important to use industry-specific keywords or technical terms to enhance
skills and experiences. If you can more clearly define your experiences, skills, and abilities, the
employer will be more likely to move you forward in the hiring process.
When it comes to writing your experience descriptions, you want to mention skills and
accomplishments that show you would be a good fit for the position. Your resume should
be tailored to each specific position. Under each experience you want to list about 2-4 bullet
points, not full sentences. An effective bullet point references skills or projects you completed
that produced tangible results, usually positive results for an employer. Try to quantify your
bullet points whenever possible! Add numbers to help strengthen your bullet points. There
are three key elements to an effective bullet point: a strong action verb, what you did, and the
results.

Effective Bullet Point Formula

strong action verb + what you did + result
Weak Example:
• Taught students English
Strong Example:
• Taught 18 fourth grade students grammar and composition resulting in an overall
increase of 2 letter grades
See the list of action verbs on p. 10 All verb tenses should match the position. A present
position should be in present tense while a past position should be in past tense. When
creating your bullet points, think about the transferable skills you gained that would apply to
the position for which you are applying. See a list of transferable skills on p. 12.

Dos and Don’ts of Resume Writing
•
•
•
•
•
•
•
•
•
•

Be consistent with formatting and design
Be positive and honest
Get your resume proofread for spelling and grammatical errors
Present your skills in the language of the employers, industry, or profession
Do not use personal pronouns (I, me, we, us)
Do not use abbreviations unless you have already identified the abbreviation (e.g.
Student Activities Board (SAB) – you may then use SAB throughout).
Do not mention salary expectations or wage history
Do not list personal information including age, marital status, political affiliation,
religion, or nationality
Do not include a picture
Do not list hobbies or social interests unless they are directly related to the position
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Final Resume Checklist
Use this Final Resume Checklist to confirm your resume is ready to submit to an employer:
All information highlights skills and accomplishments
££ Dates, titles, and locations are listed for every experience section item
££ Each experience is described with multiple accomplishment statements which are brief
and clear
££ All descriptions in experience section use action verbs while providing comprehensive
details
££ All items are bulleted appropriately
££ Font, size, and text formatting increases visual appeal
££ Resume uses spacing to be eye-catching
££ Resume is one or two complete pages
££ Includes suggested components and additional sections to enhance resume
££ Document has no instances of spelling or grammar errors

Career Development Center
The Career Development Center offers appointments free of charge for current UofL students.
Students can meet one-on-one with staff members to discuss major/career exploration, get
assistance with resume/cover letter writing, find an internship or job, and more!
For resume development and review, you should first stop by our drop-in hours, no
appointment necessary! Meet with a Peer Career Advisor or Career Coach for a quick 10-15
minute chat about your resume. You can also submit your resume for review online through
our Document Drop Program. Visit the Career Development Center website to submit your
resume. If you need additional assistance, schedule an appointment with your Career Coach.
Drop-In Hours: Monday-Thursday, 11 a.m. to 2 p.m. in the Career Development Center
Appointment Hours: Monday-Friday, 9 a.m. to 5 p.m.
Students: Log-in to Cards Career Connection powered by Handshake to schedule your
appointment.
Alumni: Contact the Career Development Center to schedule an appointment.
Find more information about appointments, drop-in hours, and our contact information on our
website.

PLEASE NOTE:
•
•
•

 tudents from the College of Business are served by the Ulmer Career Management
S
Center.
Students from the J.B. Speed School of Engineering are served by the Speed Career
Development Office.
Students from the Brandeis School of Law are served by the Office of Professional
Development.
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Resume Power Words
Management skills

Communication skills

Clerical or detailed skills

analyzed
assigned
attained
chaired
contracted
consolidated
consulted
delegated
directed
executed
excelled
improved
increased
managed
mastered
maximized
minimized
oversaw
planned
prioritized
produced
recommended
responsible for
reviewed
scheduled
strengthened
supervised

addressed
arbitrated
authored
began
contacted
corresponded
developed
drafted
edited
efficiently
expressed
formulated
influenced
interpreted
lectured
mediated
moderated
motivated
persuaded
promoted
publicized
recruited
reported
spoke
translated
thoroughly
utilized

approved
arranged
catalogued
classified
completed
compiled
dispatched
effectively
generated
implemented
insured
monitored
observed
participated
played a vital part
prepared
presented
processed
proposed
purchased
recorded
retrieved
screened
specified
specialized
successfully
validated

Research skills

Technical skills

Teaching skills

achieved
collected
compared
compiled
conducted
critiqued
cut time/costs
discovered
evaluated
examined
gathered
identified
inspected
interviewed
investigated
organized
prevented
resolved
specialized
summarized
surveyed

assembled
associated
assured
built
carried out
confirmed
devised
engineered
expanded
launched
maintained
operated
overhauled
predicted
programmed
remodeled
repaired
shortened
solved
trained
upgraded

adapted
coached
contributed
communicated
coordinated
emphasized
enabled
encouraged
ensured
explained
guided
handled
helped
independently
informed
initiated
instructed
led
made
set goals
stimulated

Financial skills

Creative skills

Helping skills

administered
advanced
allocated
audited
balanced
budgeted
calculated
computed
concluded
estimated
exceeded
marketed
negotiated
obtained
projected
raised
reduced
researched
secured
substantially
sustained

accomplished
acted
acquired
conceptualized
combined
created
designed
established
explored
fashioned
founded
illustrated
instituted
integrated
introduced
invented
originated
performed
revitalized
shaped
visualized

advised
advocated
aided
anticipated
assessed
assisted
cared
clarified
collaborated
cooperated
counseled
demonstrated
diagnosed
educated
expedited
facilitated
familiarized
mentored
recognized
referred
represented
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Formatting in Microsoft Word
1.

 on’t use a MS Word template! Microsoft Word has beautiful designs, but it may be
D
difficult to make changes for your personal use. Instead, look at the resume examples on
our website to create a resume that will suit your needs.

2. Changing Margins. Change the margins! Click on the ‘Page Layout’ tab and click on
‘Margins.’ You can choose one of the pre-set options or click on ‘Custom’ to create
your own. Another option is to click on the line on the rule bar that indicates the
margin and drag the line up or down, or side-to-side. We recommend anything
between 0.5” to 1” margins.
3. Manual Tabs. Tabs are extremely helpful for formatting your document, especially when
you want to align text perfectly without having to hit ‘Tab’ or
the space bar to move it over. On the ruler, you can set a
manual tab on the left, middle, and right side of your
document by clicking the tab selector on the top-left corner
of the ruler. Just keep clicking until it shows the type of tab you want and drag it to the
margin you want to start typing from.
4. Copying Formatting. The Format Painter makes it happen quickly. Just
select the portion of the document you want to copy by highlighting it
and click the ‘Format Paint’ option (the little paint brush on the top left
of the Home Tab). Then, select the section that you want to apply the
formatting to.
5. Bullet Points. To create bullet points, you click on the ‘Bullets’ button on
the Home Tab. If you click on the tiny arrow right beside it, you can select
the shape of your bullet, but we recommend the solid black circle.
6. Creating Borders. In order to separate sections, some individuals like to
add a horizontal bar in their documents. An easy way to do this is by highlighting the text
and clicking on the ‘Border’ button. You can change the look of the line
by clicking on the small arrow to the right of the ‘Border’ button and
selecting ‘Borders and Shading…’. This will open up a window for you to
change the design, weight, and color of the line.
7. Hyperlinks. Adding a link to your website, portfolio, or social media profile? Right click on
the text you want to add a link to and select ‘Hyperlink.’ On the menu screen, review the
text shown in the ‘Text to Display’ field. Insert the web address in the ‘Address’ field, and
click ‘OK’. Check if the link is working by holding down the CTRL key and clicking the link to
open it.
8. C
 hanging Font Case. You can quickly change your headings’ case by highlighting text and
clicking on the ‘Aa’ button next to the font adjustment options. A dropdown menu pops up
so you can make your selection. This allows you to change a
word to all lowercase, capitalize the first letter of a sentence or
every word in a sentence, or capitalize every letter.
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Transferable Skills Checklist
Over the years, you have developed skills from coursework, co-curricular activities, work, and
life experiences. If you have researched topics and written reports or edited and presented
papers for your classes, you have used skills that are not limited to just one discipline but are
transferable to many different occupations or disciplines. A prospective employer expects you
to be able to apply the skills you have learned in college and throughout your life to the work
environment.
Use the following checklist to help you identify some of your transferable skills.
Communication Skills
££ speaking effectively
££ providing appropriate feedback
££ writing clearly and concisely
££ negotiating
££ listening attentively and objectively
££ expressing ideas
££ persuading
££ facilitating group discussion
££ reporting information
££ interviewing
££ describing feelings
££ editing
££ public speaking
££ responding appropriately to feedback
££ using various styles of written
communication
££ conveying a positive self-image to
others
Research/Planning/Investigation
££ forecasting/predicting
££ creating ideas
££ developing evaluation strategies
££ identifying problems and analyzing
££ testing validity of data
££ imagining alternatives
££ designing an experiment or model
££ identifying resources
££ formulating questions
££ gathering information
££ solving problems and making
conclusions
££ setting goals
££ observing and discovering
££ extracting important information

Human Relations/Interpersonal
££ developing rapport
££ being patient
££ being sensitive
££ interacting effectively with peers and
others
££ listening
££ persuading others
££ conveying feelings
££ being willing to take risks
££ providing support for others
££ teaching/instructing others
££ motivating
££ demonstrating effective social
behavior
££ sharing credit
££ perceiving feelings and situations
££ helping others
££ working with diversity or multi-cultural
issues
Organization/Management/Leadership
££ initiating new ideas and tasks
££ delegating responsibility
££ handling details
££ teaching/instructing
££ coordinating tasks
££ promoting change
££ coaching/mentoring
££ selling ideas or products
££ counseling
££ making decisions with others
££ cooperating
££ analyzing tasks
££ keeping a group “on track”
££ identifying people who can contribute
to solutions
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